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1 Introduction to the XML Mapping Editor

The EntireX XML Mapping Editor allows you to map XML document structures to IDL libraries,
programs and parameters. The mappings can be defined for the request and response to the
server application, or from the server to the client. The input for the XML Mapping Editor can be
a Software AG IDL file and/or an IDL-XML mapping file (perhaps produced by a previous XML
Mapping Editor session or by importing a WSDL file, XML Document or XML Schema). The output
is an IDL-XML mapping file, other XML structure definitions (such as sample XML files), and
perhaps a created or changed IDL file.

With the XML Mapping Editor you can:

® Generate XML structures and IDL-XML mapping files for code generation and runtime compon-
ents.

® Modify the XML structures.

® Modify the mapping links of IDL and XML structures.

" Validate existing or user-modified XML structures and IDL-XML mapping links.







2 Using the X

ML Mapping Editor

= Starting the XML Mapping Editor
= The XML Mapping Editor Pages
= XML Schema Export ...............
= XML Mapping Editor Settings ...
= Removing Unused Namespaces




Using the XML Mapping Editor

See also Using the XML Tester.

Starting the XML Mapping Editor

» To start the XML Mapping Editor

In the EntireX Workbench
s Double click on an XMM file.

Or:

Select an IDL or XMM file and choose Open With > EntireX XML Mapping Editor.

If the XMM file for the selected IDL file exists, the XML Mapping Editor loads this. The

Generate button is disabled because a mapping exists.

|G excample, xmm 20 = 0| 3= outline 52 ==
L
R = EXaMPLE
Overview SoP caLe

+ General Information

This section describes general information about this mapping:

Software &G [0L File: CHleclipse-SDK-3.4, 2-win32\WarkspacewS1_screensiexanmple.idl
¥MM Mapping File: Crleclipse-SDK-3.4. 2-win32\Workspace|\wal _screensiexample. xmm

= Mapping Parameters

Subset of available Mapping Pararmeters. Ta get the Full list, Fallow the Link belaw or choose the Mapping
Parameter page directhy, =

Mamespace URI: | urn;com-softwareag-entirex-rpo; %:l-%p
Enable Mull Yalue Suppression
| Mapping Parameters Get the full lisk of Mapping Parameters

+ Mapping

Choose a mapping stvle For all programs and directions, Existing mappings will be overwritten!

() Element O attribute ) s08p (#) Customized I
= Tesking

Test this Mapping by launching the XML Tester:

4 Quick Test Launch the XML Tester,

4 HTTP Test Requires a running $MLISOAR Liskener,

~ Yalidation

Make all the available Yalidity Checks in all Programs: Element Mames, attribute Mames, walidate the XML

Mode Properties, the XML Node Mapping, the encoding when using unicode data bvpes, look for existing
Mamespace Prefix definitions used in xsi:bype attributes and inform about unmapped I0L Parts.,

] validate Start the Validation

Crverview | WML Request | XML Response | Mapping Parameters | $ML Samples

3 Operation (A1) In

3 Cperand_1 (I4) In

3 Cperand_2 (I4) In

3 Function_FResul: {I4) RESULT
P powER

3 Cperand (I4) In

3 Function_FResul: {I4) RESULT
P HELLD

® Clent (a30) In

P wail (430) Inout
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Using the XML Mapping Editor

If no XMM file exists for the IDL file, the mapping style is set to "SOAP" as default value.

Choose the required mapping style and press Generate.

|G excample, xmm 20 =08

Overview

+ General Information
This section describes general information about this mapping:
Software &G IDL File:  CHleclipse-5DK-3.4, 2-win32\Workspace\v&1_screensiexample.idl

¥MM Mapping File: Crleclipse-SDK-3.4. 2-win32\Wworkspace|\wal _screensiexample. xmm

= Mapping Parameters

Subset of available Mapping Pararmeters. Ta get the Full list, Fallow the Link belaw or chaose the Mapping
Parameter page directhy,

Mamespace URI: | urn;com-softwareag-entirex-rpo; %:l-%p
Enable Mull Yalue Suppression

| Mapping Parameters Get the full lisk of Mapping Parameters

+ Mapping

Choose a mapping style For all programs and directions, Existing mappings will be overvwritten!
) Element () aktribute (=) 30ap () Customized

+ Testing

Test this Mapping by launching the XML Tester:
4 Quick Test Launch the XML Tester,
4 HTTP Test Reguires a running xMLISOAR Liskener,

~ Yalidation

Make all the available Yalidity Checks in all Programs: Element Mames, Attribute Mames, walidate the XML
Mode Properties, the XML Node Mapping, the encoding when using unicode data bvpes, look for existing
Mamespace Prefix definitions used in xsi:bype attributes and inform about unmapped I0L Parts.,

] validate Start the validation

Crverview | WML Request | XML Response | Mapping Parameters | $ML Samples

» To close the XML Mapping Editor

s From the File menu, choose Close.
Or:

Click the Close icon in the editor title bar.

B= outline &2
= 4% ExaMPLE
=P caLC
3 Operation (A1) In
3 Cperand_1 (I4) In
3 Cperand_2 (I4) In
r Function_FResul: {I4) RESULT
= 2F POWER
3 Cperand (I4) In
3 Function_FResul: {I4) RESULT
=P HELLD
® Clent (a30) In
P wail (430) Inout

If the current XML mapping has not yet been saved, a dialog box appears from which the close
operation can be stopped or the IDL- XML mapping can be saved. An XML mapping that is not
clean is indicated with a leading asterisk in the file name, displayed in the editor title.
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Using the XML Mapping Editor

The XML Mapping Editor Pages

= Qverview Page

= XML Request Page

= XML Response Page

= Mapping Parameters Page

= XML Sample Documents Page

Overview Page

The Overview Page is the central page and provides sections for file information, the most important
mapping parameters, mapping generation, testing and validation.

6 EntireX XML Mapping Editor



Using the XML Mapping Editor

EEf Eample.xmmm - = B
Overview
+ General Information
This section describes general information abouk this mapping:
Software &G IDL File:  CHheclipse-30K-3.4, 2-win32\Workspacelv3l _screenstexample.idl
#MM Mapping File: Ceclipse-a0K-3. 4, 2-win32\WorkspacelwS1 _screens)example, xmm

+ Mapping Parameters

Subset of available Mapping Parameters, Ta get the Full list, Fallow the Link belaw or chaose the Mapping
Parameter page directly,

Mamespace URI: | urncom-safbwareag-entirex-rpe Sal-%p
Enable Mull Yalus Suppression

|EE Mapping Parameters Get the Full list of Mapping Parameters

* Mapping

Choose a mapping style for all programs and directions. Existing mappings will be overwritten!
) Element () attribute (®) 30aP () Customized
+ Testing

Test this Mapping by launching the =ML Tester:
4 Quick Tesk Launch the XML Tesker,

4  HTTP Test Requires a running <MLSOAP Liskener,

+ Yalidation

Make all the available Yalidity Checks in all Programs: Element Marmes, Attribute Mames, validate the =ML
Mode Properties, the XML Node Mapping, the encoding when using unicode data types, look for existing
Mamespace Prefix definitions used in xsi:kvpe attributes and inform about unmapped I0L Parts,

4] validate Start the Yalidation

Crverview | %ML Request | XML Response | Mapping Parameters | ML Samples

These sections are:
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Using the XML Mapping Editor

* General Information
This section describes the names and locations of the selected XML Mapping (XMM) file and
the related IDL file.

" Mapping Parameters
Provide the Namespace and Null Value Suppression controls and contains a link to the Mapping
Parameters page

" Testing
Allows you to launch the XML Tester in Quick mode or HTTP mode.

" Validation
Make the validity checks in all programs and report the result in a new dialog. Detected problems
will be displaced in the Problems view

® Mapping
Start the Mapping generation for all Programs.

| Note: Existing Mappings will be overwritten!

XML Request Page

This page contains the Mapping Tree of the XML Request, which is linked together by mapping
paths with the IDL tree in the Outline View.

|Em excample.xmm 53 = O 5= outlire 52 cl =

o @ ExaMPLE
P calc
3 Cperakion (A1) In

XML Request

Mapping p Cperand_1 (14) In
= [e] SOAP-EMV:Envelope P operand_z (1) In
=I-[e] SOAR-ENY:Header P Function_Result (I14) RESULT
[e] soaPaction [idprog: CALC ] 5P powER
=I-[8] SOAP-EMV:Eody P operand (I4) In
=-[8] miCaLC [idlprag: CALC ] P Function_Pesult {143 RESULT
8] Operation [idliCALC [ Operation ] J-2P HELLo
B Cperand_1 [idiCALC f Operand_1 ] P client (as0) In
[e] operand_2 [idlCALC | Operand_2 ] P il {4800 Inout

Overview | XML Reguest | ZML Response | Mapping Parameters | XML Samples

The XML Request shows the XML tree loaded or created so far for the selected IDL program. The
XML tree can be modified in various ways. See IDL to XML Mapping with the XML Mapping
Editor.
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Using the XML Mapping Editor

The Outline View shows the IDL tree of the currently selected IDL file. The IDL tree display has
the same functionality as the IDL Editor's tree display; however, due to the fact that every IDL
program must be separately mapped, only one of the IDL program tree nodes can be expanded.

Use the right mouse button to display the context menu. Double-click on a tree node to display
detailed information on that node. The following keyboard options are also available in the XML
request mapping area:

Key Description

A or SHIFTHINS |Create new parameter node after currently selected one.

D or DELETE Delete the selected IDL tree node.

F Find IDL node with given name pattern.

Ior ALTHINS  |Create a new group parameter node.

L Create new IDL library node.

M Find mapped XML node for selected IDL tree node.
N or INS Create new parameter node.

O or CTRL+INS |Create new RPC program node.

P or ALT+ENTER |Open property dialog on selected IDL tree node.

R Rename the selected IDL tree node.
F3 Follow-up of M, find next mapped XML node for selected IDL tree node.
XML Node Properties Dialog

The XML Node Properties dialog contains the XML node details, the bottom panel contains
namespace settings.

EntireX XML Mapping Editor 9



Using the XML Mapping Editor

&= XML Mapping Editor

ML Node Properties
Properties of Operation [ idl:CALC | Operation ]

Element Mame: Dperation

Mapped to: CALC | Operation

Format:

Walue Length:

Defaulk Yalue:

Mamespace Prefix:

Min, DCourrence: 1

Max, DCcurrence: 1

Full Walue Suppression: | Mo Suppression

Millable: Fi

Defaulk URI:

Table of defined Mamespace definitions:

Prefix Mamespace | Insert...

Edit. ..

Remove

Defaul:

Zancel

10 EntireX XML Mapping Editor



Using the XML Mapping Editor

» To open the XML Node Properties Dialog
= Double-click on an XML node in the tree display.
Or:
Choose the Properties menu item in the context menus.
Or:
Select an XML tree node and press Enter.
The XML Node Properties can be modified. The node details panel consists of two subpanels.

The upper panel contains the following;:

Item Description
Element or Name of the element or attribute.
attribute name
Mapped to The IDL mapping link in the full path name format. For error (fault) trees, context
information.
Program Combo Box
Mapping No No Program Mapping
Element value | The value of this node identifies the program
Element name | The name of this node identifies the program
Format Format IDL
string A, AV K, KV
- G
I1 (deprecated) In
12 (deprecated) 12
14 (deprecated) 14
I8 (deprecated) 14
integer 11,12, 14
date D
time (deprecated) T
dateTime T
float F4, F8
Boolean L
binary B, BV
number N, P NU, PU

EntireX XML Mapping Editor "



Using the XML Mapping Editor

ltem

Description

Format IDL

For Tamino/special nodes: Describes the data type of the Tamino node (for example,
integer, string).

Value Length

The length parameter contains the length or precision of the data type, i.e.

® length of string for alphanumeric

® length of field in bytes for binary

length of string representation for floating point
® length of string representation for integers

® length of string for Kanji

= Jength of bit vector for logical (Boolean)

Length V is legal for string types. It denotes variable-length strings, e.g. alphanumeric
or Kanji.

For Tamino/special nodes: Length of the storage reserved for the data must match format.

Default Value

Must match the data type of the node, e.g. do not use alphanumeric defaults for integer
nodes. Defaults that cannot be interpreted by the runtime component are ignored. See
also Assigning Default Values.

Namespace Prefix

Contains the namespace prefix to the tag name.

Min. Occurrence

The minimum and maximum occurrence properties are numeric values greater than or
equal to zero. They describe the number of allowed occurrences of the node in the
incoming XML, and the number of occurrences to be generated in the outgoing XML.
The minimum occurrences value must be less than or equal to the maximum occurrences
value. Incorrect settings will be found in the validity check Validate XML node properties.
If Min. Occurrence is greater than 0 for incoming documents, the corresponding attribute
or element is required, i.e. must be set.

Max. Occurrence

See Min. Occurrence.

Null Value
Suppression
(NVS)

Specify suppression of null values (NVS), that is, whether empty elements or attributes
may be omitted in the outgoing (generated) XML documents. Mainly determined by
Min.Occurrences and Max. Occurrences as follows:

= For min =0, max = 0, there is no NVS.

® For min = 0, max = 1, the element / attribute may be omitted if empty.

® For min =0, max > 1, you can omit all empty elements or just omit empty elements at
the end of the sequence (trimming).

® For min =1, max =1, there is no NVS.

® For min =1, max > 1, you can omit all empty elements or just omit empty elements at
the end of the sequence (trimming).

® For 0 <min < max, you can omit all empty elements or just omit empty elements at
the end of the sequence (trimming).

12
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Item Description
It is also possible to suppress an attribute (independent of its value) if the associated
element has a null value and null value suppression is enabled; to do this choose Depends
on element in property Null Value Suppression.
For the data types, the following null values are defined:
Format NVS Default
string " " (empty string)
- "" (empty string)
I1 (deprecated) 0
I2 (deprecated) 0
14 (deprecated) 0
integer 0
date
time (deprecated)
dateTime
float 0.0
Boolean false
binary Only BV with length =0; Only binaries corresponding to IDL
parameter with type BV have an NVS default [element/attribute with
data length=0].
number 0.0
Null Value If NVSis switched on, this value is compared with the values of the XML document and
it is decided whether the values need to be transmitted. The defaults are in the table for
NullValue Suppression (NVS).
Nillable If NVS is set to "No Suppression", the Nillable option is available in the dialog. If the

option is selected, an empty element is represented as an empty-element tag with attribute
xsi:nil="true".This means thatif an nillable group element only has elements without
value and without attributes, only the enclosing group tag with attribute
xsi:nil="true" is displayed.

Time Pattern

Optional for date, time (deprecated) and dateTime.
The default patterns conform to the XSD Schema 2001 specification:

date: yyyy-MM-dd, for example 2003-04-15
dateTime: yyyy-MM-dd'T'HH:mm:ss, for example 2003-04-15T18:48:23

Value for user-defined time pattern:
Letter Date or Time Component Examples

G Era Designator AD
y Year 1996,96

EntireX XML Mapping Editor 13
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Item Description
M Month in year July; Jul; 07
w Week in year 27
W Week in month 2
D Day in year 189
d Day in month 10
F Day of week in month 2
E Day in week Tuesday; Tue
a AM/PM marker PM
H Hour in day (0-23) 0
k Hour in day (1-24) 24
K Hour in AM/PM (0-11) 0
h Hour in AM/PM (1-12) 12
m Minute in hour 30
s Second in minute 55
S Millisecond 978
z General Time Zone Pacific Standard Time: PST; GMT-08:00
Z RFC 822 Time Zone -0800

Correlation of Occurrence Setting and Null Value Suppression

The value for null value suppression has a higher priority than the occurrence setting of affected
elements or attributes. The following rules apply:

1. NVS="Suppress Element"/"Suppress Attribute"
Setting NVS to Suppress Element" or "Suppress Attribute" results in a value of minimum occur-
rence of zero, which makes it optional.

2. NVS="No Suppression"
Setting NVS to "No Suppression" means that the element/attribute is always displayed so the
value of #minOccur must be 1 - otherwise the element/attribute would be optional and could
be suppressed.

3. NVS for arrays
For arrays, the dependency of minimum occurrence and Null Value Suppression is more com-
plex:

a. NVS set to "No Suppression”

For an array with fixed size the setting is #fminOccur = ffmaxOccur = #array size.

An array with variable size will contain all non-suppressable elements, but at least #fminOccur
elements. Empty elements will be generated to guarantee the number of #minOccur.

14 EntireX XML Mapping Editor
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b. NVS set to value other than "No Suppression”
The number of array elements is at least #minOccur (empty elements will be generate and
appended if number of elements is lower than #minOccur).

The lower panel is only available for element nodes and contains namespace-related properties:

Iltem

Description

Namespace URI

A default Namespace (xmlIns=

..... ) for this element node.

Namespace definitions

A table of namespace prefix / URI assignments for this element node. The

(table) listed namespaces are defined for this element and all subelements, as described
in the XML namespaces specification document. Two buttons, Add and Delete,
allow you to add or delete namespace definitions, respectively.

Using the Context Menu

The context menu of the XML tree enables you to modify the XML structure. It contains menu
items to insert new nodes, remove or rename nodes, remove an IDL mapping, change the XML
part type to element or attribute, move the selected node to the top or bottom of the current subtree,
move the selected node up or down within the subtree, or show the XML Node Properties dialog.

» To open the context menu

Select the XML tree node and click the right mouse button.

Menu Item Shortkey Description

New child node|Ctrl-N Insert a child node under the selected node.

Insert before Ctrl-B Insert a new node before the selected node.

Insert after Insert Insert a new node after the selected node.

Set to Attribute |Cti1-S Turn an attribute into an element. Also works for multiple selected nodes.

Set to Element |Ctrl-E Turn an element into an attribute. Also works for multiple selected nodes.

Bring to top Ctrl-T Move the selected node to the top of the current subtree.

Bring to bottom |Ctrl-O Move the selected node to the bottom of the current subtree.

Move up Ctrl-U Move the selected node up within the subtree.

Move down Ctrl-D Move the selected node down within the subtree.

Cut Ctrl-X Cut the selected node.

Copy Ctrl-C Copy the selected node.

Paste Ctrl-V,Ctrl-P Paste a node from the clipboard (after copy or cut).

Unmap Ctrl-M Unmap the selected IDL and XML nodes, i.e, remove link. Also works for
multiple selected nodes.

Delete Delete/Backspace | Remove the selected node. Also works for multiple selected nodes.

Rename Ctrl-R Rename the selected node.

EntireX XML Mapping Editor
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Menu ltem Shortkey Description
Properties Alt-Enter Open the XML Details Panel.
Using Drag-and-drop

You can use drag-and-drop operations within the XML tree instead of move and cut-and-paste.
Select a node (even with subnodes) and drag it to another place. The dragged subtree is then in-
serted after, before or under the corresponding drop node (to insert it under the drop node, use
the ctrl key as a toggle).

Some drag-and-drop operations are illegal, e.g. dragging a node into one of its descendant nodes
(children). This would result in a cyclic reference and is thus forbidden.

Dropping a dragged node into an attribute node will convert the attribute node to an element
node. This is because attributes may not have descendant nodes.

@y Caution: If you drag a subtree into or out of an array, the IDL mapping links of all nodes of

that subtree will be deleted. This is because the cardinality of the node occurrence has
changed, and the resulting IDL mapping is very likely to be incorrect.

Drag-and-drop from an IDL Tree Node to the XML Tree

If you drag an IDL tree node onto an XML tree node, the IDL-XML mapping link for that XML
node is changed. The new XML-IDL mapping of this XML tree node is to the dragged IDL node.
The IDL tree is not changed.

This is a quick way to change IDL mappings for XML parts. Note that there is no immediate check
for duplicate assignment of an IDL node; however, the validity checks will detect it.

XML Response Page
This page contains the Mapping Tree of the XML Response, which is linked together by mapping

paths with the IDL tree in the Outline View. The page extends the XML Request page with an
additional section, Fault Document Manager, at the bottom.

16 EntireX XML Mapping Editor
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@nexample.xmm & =g EE Outline 23 =

= 4+ ExaMPLE
=-4F calc
@POperatiun (A1) In

XML Response

Mapping
@pOperand_l I14) In
= [e] soaP-EMV:Envelope #F operand_2 (14 In
(€] SOAR-ENY:Header #F Function_Result {14) RESULT
=-[8] SOAP-ENY:Bady =4 PowER
=-[8] m:iCALCResponse [ idlprog: CALC ] #F operand (1) In

IERFunction_Result [idliCALC [ Function_Resulk ] @P Function_Result (14) RESULT

=4 HELLD
&F Clert (asm In
&F mal (a80Y InCut

¢ Fault Document Manager

Owerview | XML Request | ¥ML Response | Mapping Parameters | ML Samples

The Fault Document Manager contains the entry for the XML Fault Response Document. By select-
ing the entry, the Edit... button will be enabled. Press Edit... to display the following dialog:

& EntireX XML Mapping Editor

Fault Response

Mapping

SORP-ENY: Envelope
[e] soaP-EMY:Header
=[] SOAP-ENY:Body

=-[8] SoaP-EMY:Fault [idlprog: CaLc ]
[8] Faultcode [ info:faulkcode ]
[8] Faultskring [ info:Faulkskring ]
[8] Faultactor [ info:Faulkackar ]
[8] detail [ inFo:detail

Ik ] [ Cancel

EntireX XML Mapping Editor 17
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The same operations as for the XML Request and XML Response trees are possible. Confirm the
changes with OK, or click Cancel to exit without changes.

Mapping Parameters Page

This page covers the Mapping Parameters to affect the Mapping Structure. The default values for
that page will be managed in the preferences and can be loaded by using the Restore Defaults
button in the upper right corner.

Mapping Parameters Restare Defaults

The mapping parameters can only be used for generating a new IDL-%ML mapping.
Just changing mapping paraneters has no effect on an existing mapping; generate the mapping again For the changes to take effect.

+ Document Style

Generakte Array Envelope Element
WSOL Skvle: | document/liceral w

+ Encoding Settings
#ML Default Encoding: | UTF-8
|:| Use incoming Encoding

+ Mull ¥alue Suppression
Caontral empty elements or attributes may be omitted in the XML documents,

Enable Mull Value Suppression
Siniple Elerment: | Mo Suppression w
Simiple Attribute: | Mo Suppression w
Array Types: Cells at End (Trim) w
Complex Types: | Suppress Group Elements w

Suppress Attributes, if Element has Mull value

+ Mamespace Definitions

Table of defined Mamespace definitions:

Prefix Mamespace Defaulk

SCAP-ENY http:/fschemas. xmisoap, orgfsoapfenvelope!

xsd hikbpe e w3, org 2001 XML Chema

m urn:com-sofbwareag-entiresx-rpc: %l (default)
SCAP-ENC http:/fschemas. xmisoap, orgfsoap/encoding,

i hikbpe: e w3, org 2001 XML Cchema-instance

Overview | ¥ML Request | %ML Response | Mapping Parameters | XML Samples

Parameter Description

Generate Array Envelope Element |Determines whether for each array a surrounding additional element
(envelope) is generated or not.

WSDL Style Prepare the SOAP Mapping for selected WSDL Style. Possible values:
document/literal or RPC/encoded.

18 EntireX XML Mapping Editor
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Parameter

Description

XML Default Encoding

This encoding is used for the XML/SOAP document sent if the box Use
incoming XML encoding is not checked (for XML-based clients), or if
the XML/SOAP RPC Server is used.

Use Incoming Encoding

Check this box to enable the XML/SOAP Wrapper to use same encoding
for the incoming document as for the outgoing document.

Enable Null Value Suppression'”

Switch on/off the null value suppression.”

Simple Element"

Suppress Elements. Possible Values: No Suppression or Suppress
Element."”

Simple Attribute'” Suppress Attributes. Possible Values: No Suppression or Suppress
Attribute.”

Array Types'” Suppress Array Types. Possible Values: No Suppression, All empty
cells or Cells at end (Trim).")

Complex Types"” Suppress Complex Types. Possible Values: No Suppression Suppression

(no special handling of complex types - null value suppression defined
for 'Simple Element' is used), or Suppress Group Elements.”

Suppress Attributes, if Elements
has Null Value”

Suppression depends on the Parent Element.”

Namespace Definitions Table

Manage all Namespaces with prefix and URI.

@ For more details on null value suppression, see below or Null Value Suppression in Writing Ad-
vanced Applications with the XML/SOAP Wrapper.

XML Sample Documents Page

This page allows the generation and modification of XML Sample Documents. They can be used
to test the Mapping by sending the generated Request Document to the XML Tester. Another
useful point is to compare the XML Sample Document structure with the real XML Document
returned by your application to detect differences, for example Namespace Definitions, typos or

anything else.

EntireX XML Mapping Editor
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ety exarnple cmnm 57 = B
XML Sample Documents T
DL EML Documents
= @" EXAMPLE <vuml version="1,0" encoding="UTF-3" 7=
= @P CaLC <1-- Generaked by Software A&, Entires XML Mapping Editor

S0AP-EMY Envelope xmins: 308P-EMNY="http: | /schemas, xr
<S0AP-EMNY:Header =

[ERF equest Document:

|= Response Document < l-- SS0APACkon =CALC < SOAPACkon = -- =
POWER. < SOAR-ENY  Header =
§: <S0AP-EMV: Body =
HELLC < CALC xmilns:rm="urn: com-softwareag-enkirex-rpo Ex

<Operation =M Operation =
=0perand_1 =-1686024913 < Operand_1 =
“0perand_2=-1252560089 < Operand_2 =
Al =
<}S0AP-ENY: Body =
< [S0AP-EMNYEnvelope =

¢ |

|

Crverview | ML Request | XML Response | Mapping Parameters | XML Samples

All generated XML Sample Documents can be stored in parallel to the selected XMM file by using
the Save All toolbar button in the upper right corner of this page or the Save command in the
context menu. The generated file name is built as follows:

[xmm name] .[library namel.[program name].[direction (request | response)].xm]

For example: example.EXAMPLE.CALC.request.xm]

If a file already exists, a dialog will prompt you for confirmation to overwrite it.
Using the Context Menu of XML Samples

The XML Samples context menu allows the generation of XML Sample Documents.
There are two different menus:

® Library or Program is selected
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zenerate 4l

Requesk

Save Fesponse

Generate All means both directions (Request and Response). When a Library is selected, the
commands here will be inherited by all Programs.

* Request or Response Document is selected

aenerate
Delete

“ML Tester. ..
Save

The XML Tester... command sends the selected XML Sample Document to the XML Tester as
Quick Test and enters the name of the XMM file.

XML Schema Export

The current XML Mapping can be exported as XML Schema, using the context menu of the XMM
file. The XML Schema style "Russian Doll" or "Venetian Blind" can be selected in the preferences.
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(8 Parkag &3 T Hierarc | — O
==
= 1= Demo
# src
B, IRE Swstem Library [jren]
@,! excample.idl
@ﬂ example, xmm
M k

Dpen F3
Cpen \With »
Show In Alb+Shift+i #

oy Chel+C
opy Qualified Mame
aske Chrl+Y

Co
Zo
5 Pa
Delete Delete

ﬁ tnt ﬂl IIIII

Eiild Path k
Refactar alk+shife+T

-

£y Import,..
L7 Export...

q;,** Refresh F5
Assign Warking Sets. ..

Test Software G XML,I'SOF'.P mapping

Generake xML Schema |

Generate Web Service from Entire Mapping ...
Deploy to Entirex XML/SCAP RPC Server...
Fun As

Debug As

Team

Compare With

Feplace With

v ¥ v v v

Properties Alt+Enter

The generated XML Schema files will be stored in parallel to the selected XMM file, where one
file represents the direction (request or response) and the defined prefixed element.

For example: a SOAP mapping creates four files from the example CALC program: two prefixes
("SOAP-ENV" and "m"), and two directions (request and response). The generated file name is
built as follows.

[xmm namel.[1ibrary namel.[program namel.[direction (request |
response) ][ (optional).additional prefix].xsd
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Example

® example. EXAMPLE.CALC.request.xsd

® example. EXAMPLE.CALC.request.m.xsd
® example. EXAMPLE.CALC.response.xsd

* example. EXAMPLE.CALC.response.m.xsd

If a file already exists, a dialog will prompt you for confirmation to overwrite it.
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XML Mapping Editor Settings

The preference page XML Mapping Editor manages the default values.
For XML Schema the style "Russian Doll" or "Venetian Blind" can be selected.

All other parameters are described under Mapping Parameters.

& Preferences

|t\,-'pe filter text | »ML Mapping Editor

General

Ant —_
Connectivity Dacument Setting | Namespaces | Mull value Suppression | ML Schema Expart

Help XML Schema Export
InstalfUpdate #ML Schema Skvle
Internet (®)Russian Dol () Yenetian Blind
Java
P4
Plug-in Development
Repark Design
RunfDebug
Server
Software AG
=~ Entires
C Wrapper
COBOL Wrapper
Cuskam \Wrapper
DCOM Wrapper
Deployment Environments
EIB Wrapper
1DL Extractor For COBOL
1DL Extractor For Matural
10L Extractor For PLJT
Inskallation
Java Wrapper
FLIT Wrapper
RPC Environments
ML Mapping Editor

Proxy Settings

DDI Reqiskries

Web Services Stack
30U Development
Tearn
Yalidation

Wieb and XML
Web Services
#Doclet

Store all general XML Mapping Settings and various Export Settings For XML Schema,

o] B

[0 B -

l Restore Defaulks ] [ Apply ]

'\?,' I Ok l [ Cancel ]
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Removing Unused Namespaces

> To remove one or more unused namespaces

1 Open the XML Mapping Editor for the XMM file.
2 Select tab XML Request.

|Eai exammple.xrm - 53 =B
XML Request

Mapping

ERCIRSCAP-ENY Envelope
=I-[e] SOAP-EMY:Header
le] soaPaction [idlprag: CALC ]
= [8] SOAP-EMY:Body
=I-[8] m:CALT [idlprag: CALC ]
8] Operation [ idiCALC J Operation ]
8] Operandl [idhiCALC J Operandl ]
e8] OperandZz [ idhiCALC J Operandz ]

Overview mML Request TEML Response | Mapping Parameters | #ML Samples

3  Select the element that defines namespace(s) to be removed.

4  From the context menu, choose Properties.

EntireX XML Mapping Editor 25



Using the XML Mapping Editor

& XML Mapping Editor

XML Node Properties
Properties of SOAP-ENY:Envelope

Element Mame:

Mapped to:

Eormat:

Mamespace Prefix: | SOAP-EMNY

Min, Qccurrence: | 1

Max, Occurrence: | 1

mull walue Suppression: | Mo Suppression

Millable: A

Diefault URI: |

Table of defined Mamespace definitions:

Prefix Mamespace Defaul: | Insert...

SOAP-EMY htkp:ffschemas, xmlsoap, org/soapenvelope)
*mm htkp:f fnamespace. softwareag, comentiresxgxml. .. Edit...
xsd hikkps f e w3, org 2001 ¥MLSchema
SOAP-ENC httpsffschemas, xmlsoap, orgfsoapfencading) Remayve

i hikkps f e w3, org 2001 [ ¥MLSchema-instance

Defaulk

l l Cancel

5  Select (unused) namespace entry/entries in list and choose Remove.

6  Press OK.
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7  Repeat these steps for the XML response (select the XML Response tab and repeat the steps
above).

8  Save the XMM file.
9  Switch to XML Samples tab, which shows the following:
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& XML Mapping Editor

XML Node Properties
Properties of SOAP-ENY:Envelope

Element Mame:

Mapped to:

Eormat:

Mamespace Prefix: | SOAP-EMNY

Min, Qccurrence: | 1

Max, Occurrence: | 1

mull walue Suppression: | Mo Suppression

Millable: A

Diefault URI: |

Table of defined Mamespace definitions:

Prefix Mamespace Defaul: | Insert...

SOAP-EMY htkp:ffschemas, xmlsoap, org/soapenvelope)
*mm htkp:f fnamespace. softwareag, comentiresxgxml. .. Edit...
xsd hikkps f e w3, org 2001 ¥MLSchema
SOAP-ENC httpsffschemas, xmlsoap, orgfsoapfencading) Remayve

i hikkps f e w3, org 2001 [ ¥MLSchema-instance

Defaulk

l l Cancel

10 The XMM file defines the following:
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<FromXml>

<Method relatedIdlLibrary="EXAMPLE" relatedIdlProgram="CALC" encoding="UTF-8"
uselncomingEncoding="true">

<XmTNode name="Envelope" Tength="0" min="1" max="1" namespacePrefix="SOAP-ENV"
nullSuppression="NVS_NONE" nullValue="" >

<XmlNamespaceDef <«

prefix="SOAP-ENV" uri="http://schemas.xmlsoap.org/soap/envelope/" />
<XmlNamespaceDef <«

prefix="SOAP-ENC" uri="http://schemas.xmlsoap.org/soap/encoding/" />

<XmINode name="Header" Tength="0" min="1" max="1" namespacePrefix="SOAP-ENV"
nullSuppression="NVS_NONE" nullValue="" >

<XmlNode name="SOAPAction" format="string" type="xsd:string" Tength="0" min="1" <
max="1"

default="CALC" nullSuppression="NVS_NONE" nullValue="" programNode="ev" >
</XmlNode>
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B NErOdUCHION 10 T8 XML TS O .. ettt

= XML Tester Options ..

= Using the XML Tester

B XML Tester for Conversational RPC ........ooviii e e

31



EntireX XML Tester

Introduction to the XML Tester

Using the XML Tester you can send an XML document to the EntireX XML/SOAP Listener.

The XML Tester supports drag-and-drop editing, and you can restore the last used session within
a workspace. If the mapping file has changed, the views for request and response are cleared.

The XML Tester is provided by the EntireX Workbench as an Eclipse View and can be opened
from the XML Mapping Editor or XML/SOAP Wrapper. It is also accessible from Windows >
Show View > Other... > Software AG > XML Tester. The following test modes are available:

® Quick Test (Using the Java Interface)
® HTTP Test (Using the EntireX XML/SOAP Listener)

See sample screen and description of options below.
(2 Protlems | @ Javadac | [2, Declaration | Progress |[mf =ML Tester 52 e BB T O

(E)HTTP Task (2ML/SOAR Listener) HTTP URL: | http:/flocalhost: 49991 hwsstack/services b

(7 Quick Test #MM or A&R File: | Diiworkspaceexample xmm -
Input *ML Document:

Tree View | Text Yiew | Raw Yiew

<1-- Generated by Software AG, Entirel XML Mapping Editar (0.0.0.product) on 2010-01-21 at 16:36:39 --= ~
<miCALC xminsim="urn;com-softbwareag-entirex-rpo: EXaMPLE-CALC" =
<Cperation =+ </Operation =
«Cperandl =21 <f0perandl =
<0perandz? =6 </Operandz =
i al O

Tree View | Text Yiew | Raw Yiew
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XML Tester Options

Name

Type

Description

Quick Test

Check box

Check this box to test the Java interface of the XML/SOAP Runtime.
If checked, the Settings action will open the Quick Test Details
dialog.

XMM or AAR File

Text field

The AAR file, which contains one or more mapping files (XMM
files), or the XMM file, which contains the mapping information.
Accept absolute path. If the file does not exist, the action Create
Sample XML... is disabled. When the file is found, the Broker ID
and Server Address are read and the corresponding fields in the
Quick Test Details dialog are filled.

Combo box

Behavior depends on content of field XMM or AAR File:

= [f this field contains an AAR file, this combo is enabled and filled
with all the mappings stored in the archive. Select the mapping
you want from the list.

= If this field contains an XMM file, the combo box is disabled.

Browse...

Button

Open a File open dialog to select the XMM or AAR file from the file
system.

HTTP Test

Check box

Check this box to test the HTTP interface (EntireX XML/SOAP
Listener) of the XML/SOAP Runtime. If checked, the Settings action
will open the HTTP/HTTPS Parameters dialog.

HTTP URI to
contact

Combo box

URI of the EntireX XML/SOAP Listener. Will store the last ten called
URLs.

Input XML
Document to send

Text field

File name of the XML Document to be sent.

Browse... Button Open a File open dialog to select the XML Document file from the
file system.
Create Sample Action B Open the Create Sample XML... dialog, see below. If the text file for
XML... the XMM file does not contain a valid file path, the Create Sample
XML... button is disabled.
input - area Tree/Text/Raw Input field for the XML data to be sent to the Broker, this area is
view filled with the text/tree representation of the selected file, see Input
XML Document to send. If empty, the Play action is disabled.
output - area Tree/Text/Raw Output field for the XML data response from the Broker. By default,
view the response will be displayed in platform encoding. But if the XML
data request contains a valid encoding in the XML declaration, this
encoding will be used and a tooltip text will inform you of this. This
view will also display the status and errors.
Settings Action B Open either Quick Test Details or HTTP/HTTPS Parameters dialog.

See Quick Test and HTTP Test above.

EntireX XML Mapping Editor
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Name Type Description

Play/Stop Action = //E Start the test. This action is disabled if there is no text in the input -
area.

Reset Action @ Reset the input and output areas.

Quick Test Details Dialog

Use the Quick Test Details dialog to change the Quick Test parameters. The Broker ID, Server
Address, the Security Settings, the Natural Settings can be modified for this XML Tester session.
Compression Level is a non-editable box that contains all possible values. Broker ID and Server
Address are editable dialog boxes and hold the last five used values. Use the Reliable RPC check
box to turn reliable messaging on or off (mode is AUTO-COMMIT). See Reliable RPC.

& XML Tester @

Quick Test Details

Define Quick Test parameters,

Main | Broker Security | MNatural

Eroker I0: localhost: 1971
Server Address: RPC/SRYLJCALLMAT|
Compression Lewel:

[[Juse codepage
[Jreliable RPC {auto-commit)

Ca

[

o4 l [ Zancel

XML Tester HTTP/HTTPS Parameters Dialog

With the HTTP Header tab you can add more information for the call and set the SOAPAction.
An entry must be selected to be active. The Value box holds the last five used values for the cor-
responding property. It is editable, which means you can change a value by clicking directly in

the table.
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& XML Tester, @

HTTRP/HTTPS Parameters
Manage HTTPJHTTPS Parameters

HTTF Header | HTTPS Parameters

Key Value Add
[] soapaction caLc| :
[ exx-brokerID localhost: 1971 Edi...

| 4

DElEE g

Rermone

Select Al

Deselect Al

I Ok ] [ Cancel

With the HTTPS Parameters tab you can set parameters required for an HTTPS connection. An
entry must be selected to be active. The Value box holds the last five used values for the corres-
ponding property. It is editable, which means you can change a value by clicking directly in the
table.

£ XML Tester, El
i
HTTP/HTTPS Parameters -
Manage HTTP/HTTPS Parameters #
HTTP Header | HTTPS Parameters |
Keny ialue add. .

[ javax.net.ssl.keystore |
[] javax.net.sslkeyStarePassw, .,
[ javax.net.ssl.keystareType

|4

Edit...

Remove

Select Al

Deselect Al

Ok ] [ Zancel

Add New HTTP Parameter Dialog

With the Add new HTTP(S) Parameter dialog you can add a new HTTP or HTTPS parameter.
All Software AG's predefined HTTP parameters are listed in the Key box. For HTTPS, the Key
box contains predefined properties for HTTPS communication.
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Edit HTTP Parameter Dialog

With the Edit HTTP(S) Parameter dialog you can change the value of a property. The Value box
is editable and holds the last five used values. The Key value for all predefined properties cannot
be modified.

& XML Tester,

Edit HTTP Parameter
Define key and value For the HTTP Parameter,

Key:
value: | RPCISRY1JCALLMAT]

| O

oK l l Cancel

Using the XML Tester

Using the XML Tester you can send an XML document to the EntireX XML/SOAP Listener.

» To open the XML Tester

In perspectives other than EntireX, choose Window > Show View > XML Tester, in other
perspectives, choose Window > Show View > Other ... > Software AG > XML Tester.

Or:

Choose Window > Open Perspective > Other... and select EntireX Perspective. The XML
Tester view is part of this perspective.

Or:

In the XML Mapping Editor, switch to the Overview page, choose Quick Test or HTTP Test
in the testing section.

Or:

In the XML Mapping Editor, switch to page XML Samples, select one document, choose XML
Tester in the context menu.
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» Torun atest

Load the mapping information. In field XMM or AAR File, enter the absolute path to the
AAR or XMM file that is being tested (you can use the Browse... button or a drag-and-drop
operation). If you enter an AAR file, all mappings contained in the archive are listed in the
combo box next to the XMM or AAR File field.

(&) HTTP Tesk (XMLISOAP Listener) HTTP URIL: | httpifflocalhast: 49991 fwsstackiservices v

) Quick, Test =M or AAR File: | D\Workspacemorekmm. aar - | “ | | Browse. ..

countries, xmm
Input =ML Document: eks, 2

Select the testing interface (Java or HTTP):

* Javainterface: the XMM or AAR File field must contain the full path and name of an XMM
or AAR archive. Choose the Quick Test option to use this interface.

® HTTP interface: enter the name of the URI of the running EntireX XML/SOAP Listener.
Choose the HTTP Test option to use this interface.

Complete the input area:

* Type your XML document.
® Use the Create Sample XML... button and follow the dialog.

] Note: If the IDL file contains only one library with one program, this is used for the

sample generation without opening the dialog.

Example dialog:

& XML Sample Generation |;|@@

Select a program from the corresponding library,

= 4 ExamMPLE
&P calc
g
&P HELLD
€3] oK l l Cancel ]

* Load sample document, using drag-and-drop operation on the sample page of XML Mapping
Editor or file browser.
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|t excample_new.xmm 52

= 0| 5= outine 53 =8
XML Sample Documents =) =
= 4 ExAMPLE
IDL = ZML Documents 3 = @p CaLC
= & EXAMPLE <7xml wersion="1.0" encoding="UTF-&" 7= @F‘ Operaticn (AL} Ir
B QP CALC «1-- Generaked by Software AG, Entire XML Mappil Qp Operandl (14 In
" <AL xmlns:m="urn:com-softwar e ag-ankiresx-rp @pOperandZ (14} In
l_l Request Docurment . «<Cperation =+ <Operation @pFunction_Result 1
\=| Response Docurnent  =Operandl =21 </Operandl = @p
=-4P squaRE *2operandz 6= Cperand? = = SQUARE
2 n ‘D ; <ImM AL > @pOperand {I4) In
=| Request Documen
S . P Resut (141 Out
=] Response Document A
‘\.
L]
A}
A
L1
\
LY
< ] »
1
Crverviews | XML Request | %ML Response | Mapping Parameters | XML Samples | >
i >3 S
[Z problems | @ Javadac @ Declaration | € Progress @HXML'IITester s 0 Y ﬁ =8
|
I
(E)HTTP Test (¥ML/SOAF Listener) HTTP URL: |http:HIDF'alhDst=49991ststatkiservites V|
L
jick Test ile: | Duiwiorkspacetexample. xmm -
) Quick, Tes ZMM or ABR. File | | rksp y p |
¥
Input =ML Docurnent: [ Browse...
- . | e
2
!
o,
rd
Tree Yiew | Text View | Raw View 4

| s

Request Document

Tree YWiew | Text View | Raw View

The following tabs are available:

® The Text View tab will try to color the request syntactically, making the XML easier to

read.

® The Raw View tab is initially empty. When the first request is sent, it is filled with the
exact message sent together with information on the request method and the used HTTP

headers with their values.

® From then on the Raw View is displayed and is updated with the last sent request.

Input XML file to send.

Select an existing XML document (you can use the Browse button) and enter it in the field
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4  If the testing interface is Java, the Settings action will open the Quick Test Details dialog.
The dialog contains the three tabs with the following settings:

® Main
® Broker Security

* Natural Security

See Quick Test Details Dialog.
5 Ifusing option HTTP Test, the Settings action will open the HTTP/HTTPS Parameters dialog.
The dialog contains two tabs with settings for the HTTP call:
® HTTP Header
® HTTPS Parameters

See XML Tester HTTP/HTTPS Parameters Dialog.

6  Send the request by choosing action Play. If the testing interface is HT'TP, the Sending request
dialog appears. Here you have several options:

* hide the dialog by pressing Run in Background button
® cancel the request. This will terminate the session with the server

® show details about all running Eclipse jobs

A progress bar on the Eclipse status bar shows to indicate that the request is being sent.

AWML Tester. Sending request...

L] ®MLTester, Sending request. .,

Y

[Run in Background“ Cancel ” Dekails == ]

If you used the Quick Test option, you cannot cancel the request.

7  When a response is received, it is displayed in the output area. Errors are also displayed in
the output area.

The Text View tab displays the XML response as formatted and syntactically colored text.
The Raw View tab displays the response “as is”. Information on the used request method,
response code and HTTP headers with their values is displayed for the XML response.
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XML Tester for Conversational RPC

» To use the XML Tester with conversational RPC

1 Open Settings.
[ ML Tester 532 ole B =&
& XML Tester fz|
- |
HTTP/HTTPS Parameters =
Manage HTTR/HTTPS Parameters *
HTTP Header | HTTPS Parameters |
Key alue add. ..
o] 4 ] [ Cancel l
2 Add key exx-conv and set value to "OPEN".
= XML Tester, g|
Add new HTTP Parameter -
Define key and walue For the HTTP Parameter,
Key: | B -0OnY v|
Yalue: | OPER| |
@ a4 ] [ Cancel
3  Press OK.
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& XML Tester

HTTP/HTTPS Parameters
Manage HTTP/HTTFS Parameters

HTTP Header | HTTPS Parameters

|
M S

kKey Yalue

(=]
=5
=%

[ iesx-cony OFEM

Edit...
Rernove
Select Al

Deselect Al

OF ] [ Cancel

Select exx-conv.

& XML Tester

X)

..
HTTP/HTTPS Parameters -
Manage HTTP{HTTPS Parameters =
....... | HTTPS Parameters
Iy Walue [L]
B -COmy OPEN
:
ok l l Cancel ]
Press OK.
Send the request.

The response contains the exx-xm1-sessionID used for conversational communication. This
parameter is also added to HTTP/HTTPS parameters for the next call(s) automatically. The
parameter exx-conv is deactivated simultaneously.

<l-- snippet with exx-xml-sessionID in response document -->
<axisZ2nsl:EntireX xmlns:axisZnsl="urn:com.softwareag.entirex.xml.rt">
<exx-xml-sessionID>XML610C044029044C05</exx-xml-sessionID>

{/axisznsl:EntireX>
<I-- snippet -->

To finish the conversation, open the settings again, activate the exx-conv and set its value to

"COMMIT" or "BACKOUT".

EntireX XML Mapping Editor
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10 The conversation is closed with the next sent call.
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= Command-line Options

= Example ....vvviiinnnns
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Command-line Options

See Using the EntireX Workbench in Command-line Mode for the general command-line syntax. The
table below shows the command-line options for the XML Mapping Editor.

Task Command Option Description
Create SOAP-conformant XML -map:soap
mapping for all programs. -map:soapl.l Supported for compatibility

with older versions.

Create attribute-preferred XML
mapping for all programs.

-map:xmlattributes

Create element-preferred XML
mapping for all programs.

-map:xmlelements

Create element-preferred XML
mapping with XML Schema for all
programs

-map:xmlwithxsd

-namespace

If namespace is specified, the
namespace URI for the
program node. XML Schema
uses this namespace URI as the
target namespace.

Create sample XML documents for
all programs.

-xml:sample

Example

<workbench> -map:soap /Demo/example.id]l

where <workbench> is a placeholder for the actual Workbench starter as described under Using
the EntireX Workbench in Command-line Mode.

The generated XML mapping file (XMM) will be stored in parallel to the IDL file, for example in

project Demo.

Status and processing messages are written to standard output (stdout), which is normally set to

the executing shell window.
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5

IDL to XML Mapping with the XML Mapping Editor

Mapping IDL to XML Automatically .......................
Mapping IDL to XML Manually ...............ccceeennnee
Defining the XML Encoding ...........ccooveeeiinnnennne.
Validity Checks ..........ccuvveeiiiiiiiiiiiiccicc

Exporting the IDL-XML Mapping to an XML Schema
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The EntireX XML Mapping Editor allows you to map XML document structures to IDL libraries,
programs and parameters. The mappings can be defined for the request and response to the
server application, or from the server to the client. The input for the XML Mapping Editor can be
a Software AG IDL file and/or an IDL-XML mapping file (perhaps produced by a previous XML
Mapping Editor session or by importing a WSDL file, XML Document or XML Schema). The output
is an IDL-XML mapping file, other XML structure definitions (such as sample XML files), and
perhaps a created or changed IDL file.

There are two ways to create an IDL to XML mapping: automatically (and then modify the resulting
structures manually), or manually.

Mapping IDL to XML Automatically

= Scope

= Mappings

= SOAPAction

= Using Mapping Parameters
= Mapping Parameters

= Document Style

= Encoding Settings

= Null Value Suppression

= Namespace Definitions

Scope

The following approaches are available:

" Map all programs in the current IDL file with the element-preferred strategy.
® Map all programs in the current IDL file with the attribute-preferred strategy.

Create a SOAP mapping for all programs in the current IDL file.
® Mapping and XML Schema generation for all programs in the current IDL file. This creates an

element-preferred mapping.

The mapping strategies generate XML tree nodes for all IDL parameters with the appropriate
direction:

® For IN and INOUT IDL parameters, XML Request nodes are generated.
® For INOUT and OUT IDL parameters, XML Response nodes are generated.

® Fault trees (Error trees) are generated, see Fault Document Manager under XML Response
Page.

Format, length and default values of the XML nodes are set according to the IDL parameter:
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IDL XML

IDL parameters with type A, K |Generates XML string nodes with same length.

IDL parameters with type U Generates XML Unicode nodes with the same length.

IDL parameters with type B Generates XML binary nodes with length of binary representation (base
64).

IDL parameters with type I1, 12, 14| Generates XML integer nodes, length 4, 6, 11, respectively.

IDL parameters with type F4, F8 |Generates XML float nodes, length 32 and 64, respectively.

IDL parameters with type L Generates XML Boolean nodes.

IDL parameters with type N, P Generates XML number nodes, length increased by 2.

IDL parameters with type D, T Generates XML date and dateTime nodes. The length depends on the
specified time pattern length. This is trimmed, and what is included in
single quotes will be counted, without the single quotes. Example:
yyyy-MM-dd'T'HH:mm: ss has length=19.

Variable-sized data types AV,KV |Are mapped to variable-sized strings.

Variable-sized data types UV Are mapped to variable-sized unicodes.

The resulting XML structures can be modified, see Mapping IDL to XML Manually.
The automatic mapping process can be fine-tuned by mapping parameters to be set before mapping.

For information on the attribute-preferred and element-preferred strategies see XML Structures
and IDL-XML Mapping in the XML/SOAP Wrapper documentation.

Mappings

For SOAP additional type attributes are generated. They describe the XML Schema compliant
data types of the elements.

SOAPAction

The SOAPAction tag in the SOAP header will be moved to the HTTP header. The SOAPAction
element is generated automatically with SOAP mapping. Verify the default setting. If SOAPAction
is missing, insert it: select the SOAPHeader node and add a new child node with the name
SOAPAction. Then select the new element node with the name SOAPAction, open the XML Details
panel and enter the value for that HTTP header into the Default attribute field. The NullValueSup-
pression property should have the value “Suppress Element”.
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Using Mapping Parameters

» To use the mapping parameters

1 Switch to the Mapping Parameters page or define the XML Mapping Editor preferences.
2 Check the check boxes, dialog boxes and complete the text fields you need.

Mapping Parameters

The mapping parameters are on the following sections.
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Document Style

Mapping Parameters Restore Defaulks

The mapping parameters can only be used For generating a new IDL-XML mapping.
Just changing mapping parameters has no effeck on an existing mapping; generate the mapping again For the changes to take effect.

* Document Style
Generate Array Envelope Element

WSDL Stvle: | document/liceral w

¢ Mull ¥alue Suppression

} Mamespace Definitions

Crverview | EML Request | XML Response | Mapping Parameters | ML Samples

Parameter Description

Generate Array Envelope Element|Determines whether for each array a surrounding additional element
(envelope) is generated or not.

WSDL Style Prepare the SOAP Mapping for selected WSDL Style. Possible values:
document/literal or rpc/encoded.
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Encoding Settings

Mapping Parameters Restore Defaults

The mapping parameters can only be used for generating a new IDL-XML mapping.
Just changing mapping parameters has no effect on an existing mapping; generate the mapping again for the changes ko kake effect,

b Document Style

#ML Default Encoding: | UTF-3
|:| Use incoming Encoding
b Mull ¥alue Suppression

» Mamespace Definitions

Owerview | L Regquest | XML Response |Mapping Parameters | ML Samples

Parameter

Description

XML Default Encoding

This encoding is used for the sent XML/SOAP document if the box Use incoming
XML encoding is not checked (for XML-based clients), or if the XML/SOAP RPC

Server is used.

Use Incoming Encoding

Check this box to enable the XML/SOAP Wrapper to use same encoding for the
incoming document as for the outgoing document.
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Null Value Suppression

Mapping Parameters Restore Defaults

The mapping parameters can only be used for generating a new IDL-%ML mapping.
Just changing mapping parameters has no effect on an existing mapping; generate the mapping again for the changes to kake effect,

b Document Style

} Encoding Settings

Control empty elements or attributes may be omitted in the ¥ML documents,

Enable Mull Yalue Suppression

Simple Element: | Mo Suppression W
Simple Attribute: Mo Suppression v
Brray Types: Cells at End (Trim) w
Complex Types: | Suppress Group Elsments v
Suppress Attributes, if Elerment has Mull Yalue
} Mamespace Definitions
Owerview | XML Request | XML Response | Mapping Parameters | XML Samples
Parameter Description
Enable null value suppression |Switch on/off the null value suppression.
Simple Element Suppress Elements. Possible Values: No Suppression or Suppress Element.
Simple Attribute Suppress Attributes. Possible Values: No Suppression or Suppress Attribute.
Array Types Suppress Array Types. Possible Values: No Suppression, All empty cells
or Cells at end (Trim).
Complex Types Suppress Complex Types. Possible Values: No Suppression (no special
handling of complex types - null value suppression defined for 'Simple
Element' is used), or Suppress Group Elements.

For more details on null value suppression, see Null Value Suppression in Writing Advanced Applic-
ations with the XML/SOAP Wrapper.
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Namespace Definitions

Mapping Parameters Restore Defaults

The mapping parameters can only be used for generating a new IDL-%ML mapping.
Just changing mapping parameters has no effect on an existing mapping; generate the mapping again for the changes to take effect,

b Document Style
} Encoding Settings

¥ Mull ¥alue Suppression

~ Mamespace Definitions

Table of defined Mamespace definitions:

Prefix Mamespace Default

SOAP-ENY http:/fschemas, xmlsoap,org/soapjenvelopef

wsd hikbp: f e, w3 0rg 2001 fXMLSchema

m urn:com-softwareag-entirex-rpo s %l (default)
SCAP-ENC hittp: /{schemas. xmlsoap, org/soap/encoding)

w5 hktp: /s w3, 0rgf 2001 fMLSchema-inskance

Cweryview | ML Request | ML Response |Mapping Parameters | XML Samples

Parameter Description

Namespace Definitions Table |Manage all Namespaces with prefix and URL

New namespace definitions can be entered with Add... . To change an entry choose Edit... . All
selected entries can be deleted with the Remove button. With the Default button you mark the
Namespace used for the Payload Root node, e.g. in XML Mapping the Root Element and in SOAP
Mapping the first element in the SOAP-Body:.

The Edit dialog (and similar Add dialog) looks like:

& Edit Namespace

Mamespace; |http:Il'll'schemas.xmlsoap.Drgll'snap,l'encodingll'

oK | Cancel |

» To map automatically with your preferred result

= On the Mapping section of the Overview Page choose the preferred Mapping style and press
the Generate All button.

The various generated XML Structures can be modified, see Mapping IDL to XML Manually.
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If errors/warnings have occurred, the Validity Check window will be displayed. The errors/warnings
for all programs will be found in the Problems View. In the first line of this View you will find a
short summary of the problems. If you click on an error/warning, the XML structure for it is dis-
played with the invalid node highlighted.

@y Caution: There are rare cases when the SOAP default mapping generates warnings (for ex-

ample for IDL files with cascaded arrays). A dialog is displayed stating that illegal mappings
have been generated. The warnings mostly deal with duplicate element names. You may
ignore them as long as you do not use the mapping for WSDL or XML Schema. For details,
see the Problem View.
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Mapping IDL to XML Manually

This section covers the following topics:

= Summary of Steps

= Choosing XML Request or XML Response XML Structure
= Adding an XML Node

= Grouping XML Elements or Attributes

= Mapping an IDL Node to an XML Node

= Unmapping XML Nodes

= Deleting Nodes

= Deleting XML Structures

= Modifying the Element or Attribute Name

= Changing Elements to Attributes and Vice Versa
= Assigning Default Values

Summary of Steps

» To map an IDL file manually to an XML structure or modify an IDL-XML mapping file

1 Choose direction (XML Request or XML Response).
2 Add/modify XML nodes.
3 Map IDL nodes to XML nodes.

Choosing XML Request or XML Response XML Structure

» To choose the XML Structure

1 Select the XML Request to get the IDL IN and INOUT Parameter Mapping.
2 Select the XML Response to get the IDL OUT and INOUT Parameter Mapping.

Adding an XML Node

» To create a child node to an existing (selected) XML node

1  Click on the existing node.

2 From the context menu, choose New child node.

A dialog window is displayed.
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& XML Mapping Editor

) im

ML Node Properties pu

Mew Child Mode., ..
Mew Mame: Wewharme

Mode Type

(*)Element () Attribute
[ ] Generate xml:space Attribute (Ignore other Input)

':'E‘:' | ] 4 | | iZancel

3 Enter the new node's name and type (element or attribute) and use OK.

» To insert a new node before or after an existing (selected) XML node

1 From the context menu, choose Insert before or Insert after, respectively.

A dialog window is displayed.

2 Enter the new node's name and type (element or attribute) and use OK.

Note that new attribute nodes do not have a format, length and default property assigned. You
must assign at least a format to the node before saving the mapping file. See Quick Test Details
Dialog. Use the Validity Checks to make sure that all nodes have the necessary properties.

Grouping XML Elements or Attributes

You can introduce new elements by grouping one or more existing elements or attributes. See also
XML Structures and IDL-XML Mapping in the XML/SOAP Wrapper documentation.

» To group XML elements or attributes

= Add anew XML part and move the existing nodes into the new node.

You can use cut-and-paste or a drag-and-drop operation to reorder the XML parts. Four move
functions are available in the XML context menu: Bring to top, Bring to bottom, Move up, Move
down, which are equivalent to drag-and-drop operation. See Using the Context Menu and Using
Drag-and-drop.
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Mapping an IDL Node to an XML Node

» To add (or modify) an IDL-XML node mapping link

1

Click into the Mapped to field in the XML Node Properties Dialog.

A dialog displays the possible IDL mapping links.

Choose one of the menu items to map the IDL node to the XML node.
If the XML node had a previous IDL mapping link, it is released.
Or:

Use a drag-and-drop operation to move the IDL node to be mapped directly to the XML node.
If the XML node had a previous IDL mapping link, it is released. See Using Drag-and-drop.

Or:

Use the keyboard to tab into the Mapped to text field, and press Enter. This will open the dialog
Mapped to. Select a mapping link from the list and use the OK button to confirm. Use the
Cancel button to cancel the action.

IDL-XML mapping uses the full path notation. This notation is a slash-separated list of IDL node
names, starting with the program name, ending with the addressed IDL node, and containing all
IDL nodes between program and the IDL node (the path from the program name to the node).

» To modify the format of the XML node

Select an entry from the dialog box in the XML Node Properties Dialog.

The dialog box contains the possible format values. You cannot add new format codes.

Unmapping XML Nodes

» To unmap XML nodes

1
2

Select one or more XML nodes mapped to IDL node(s).

From the context menu, choose Unmap.

This will unlink the IDL and XML nodes.
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Deleting Nodes

» To delete arbitrary elements or attributes

1  Select the node(s) to delete.

2 From the context menu, choose Delete. If nodes have descendants, the following window is
displayed:

& Delete El
9 The Mode Body contains descendant Modes, Do yvou want bo delete them as
‘““4/ well?

3  To delete the subtree attached to the node, choose Yes.

4 To keep the elements of the subtree and move them one level higher, choose NO.

@ Caution: If IDL nodes are not mapped in the incoming XML request, the result for the runtime
component is that the corresponding IDL parameters are filled with zero strings.

Deleting XML Structures

» To delete the complete IDL to XML mapping (all XML Structures)

= In the mapping menu, choose the item New mapping for all programs.

» To delete the currently selected XML Structures
s In the mapping menu, choose the item New mapping.
Modifying the Element or Attribute Name

In the automatically mapped structures the XML node names are built from the IDL parameter
names.

» To change the node name

s Choose Rename from the context menu.

Or:
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Double-click on the name field in the XML Node Properties Dialog.
To avoid accidental changes, there is no other way to modify the name.

When the name of an XML part is modified, various checks of the XML structure are performed,
e.g. attribute name duplication, IDL mapping legality. The IDL-XML-mapping link is not influenced
by the name change.

Changing Elements to Attributes and Vice Versa

You have the possibility to switch the node type between element and attribute. Note that attributes
may not have descendant nodes and namespace definitions.

» To switch between elements and attributes

s  From the context menu, choose Set to Element and Set to Attribute.
This function works for multiple nodes, too.

A\  Important: Arrays must always be modelled with elements.

Assigning Default Values

Every XML part can contain default values in case elements are missing in the incoming XML
document.

» To set the default values

»  Inthe XML Node Properties Dialog, enter a Default Value.
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Defining the XML Encoding

» To define default encoding for IDL to XML mapping
1 Open the IDL properties and choose the XML tab

7= Preferences |:|@®

XML Mapping Editor =l -

Sofk g
= Saftware Store all general xML Mapping Settings and warious Export Settings For %ML Schema,

Appling
DEEument Expansion Document Setting | Mamespaces | Mull Yalue Suppression | %ML Schema Export
[=] Entires Document Style
MET Wrapper Generate Array Envelope Element
C \Wrapper
COBGL Wirapper WSDL Style: docurnent/likeral w

Cuskom YWrapper
DCOM Wirapper Encoding Settings

Deplovment Envire .
*¥ML Default Encoding: UTF-3
EJE ‘Wrapper S

I0L Extractor for ¢ [ use incoming Encoding
IDL Extractor For I
IDL Extractor for F
IDL Extractor For \
Installation
Inkegration Server Pattern Datetime Format: | wywyy-MM-dd' T'HH:min:ss
Java Wrapper

Matural Wrapper

PLIT Wrapper

RPZ Environments

Web Service Wrap

Default Pattern for Date/DateTime Format

Pattern Date Format: wyryy-M-dd

*ML Mapping Edits
External Tools
Integration Servers

Process Development %
< >

[ Restare Defaults ] [ Apply ]

@:I I QK H Cancel l

2 Modity the Encoding Settings section:

® XML default encoding (default: UTE-8)
This is the encoding that will be used to write the mapping file itself and if there are no
XML declarations in the incoming document. Together with the next property (Use incoming
XML encoding) this encoding will be used for the response documents.

® Use incoming XML encoding (default: checked)
If this check box is checked, the last two properties are disabled and the same encoding of
the incoming document will be used for the response documents.
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Validity Checks

The Validity check is automatically performed for automatic mapping and when an existing IDL-
XML mapping file is opened, but can also be performed manually.

The following validity checks are available:

1. Checks that all elements have unique tags - produces warnings
2. Checks that all attributes of an element have unique names (mandatory)

3. Checks that the generated XML parts have correct property values (mandatory), e.g. minimum
occurrences less than or equal to maximum occurrences

4. Checks that the IDL mapping is valid (mandatory) and the IDL parameters are not mapped to
multiple XML parts (warning)

5. Checks that all IDL parameter nodes are mapped to one or more XML parts, (so that the runtime
component finds XML values for all IDL parameters or vice versa) (warning)

The first four of the checks apply to XML tree nodes, i.e. search for invalid settings or mapping
rules of XML elements or attributes. The fifth check applies to the IDL tree.

The check messages may be divided into warnings (message text starts with (W)) and errors.
Warnings can even be caused by automatic mapping. Generally, they can be ignored. Errors should
not be ignored.
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Exporting the IDL-XML Mapping to an XML Schema

» To save the XML structure tree as an XML Schema (XSD) document

s The current XML Mapping can be exported as XML Schema via the context menu of the XMM
file. The XML Schema style "Russian Doll" or "Venetian Blind" can be selected in the prefer-
ences.

See also XML Schema Parser Standards Conformance and XML Schema Writer Standards Conformance
in the XML/SOAP Wrapper documentation.
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